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El juego de la vida

Diseñado por John Horton Conway en 1970
Un tablero bidimensional poblado de «células» vivas
y muertas
La población cambia de generación en generación:

Una célula muerta revive si está rodeada por
exactamente tres células vivas
Una célula viva muere a no ser que esté rodeada de
dos o tres células vivas

Se han documentado diversos patrones que dan
lugar a comportamientos curiosos
Implementación en java disponible en linea
http://www.bitstorm.org/gameoflife/
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Objetivos de la aplicación

Elaboración de una primera aplicación funcional
Elaboración de una interfaz basada en un gráfico 2D
Utilización de clases externas al proyecto
Aprendizaje de la importancia de la gestión eficiente
de recursos
Introducción muy elemental a la utilización de hilos
de ejecución
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Requisitos básicos (muy informales

La aplicación:
Mostrará la evolución de un universo prefijado
Permitirá guardar el estado de una simulación para
recuperarlo posteriormente
Permitirá guardar y recuperar un universo desde la
memoria externa
Permitirá editar un universo en cualquier momento

Algunos de los requisitos quedarán seguramente
como ejercicio en clase
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Utilizar clases de otro proyecto

Podemos utilizar clases Java de otros proyectos
Las mismas clases pueden ser usadas en muchos
proyectos
Hay que añadir la información a las propiedades de
nuestro proyecto
Project-> Properties->Java Build Path -> Projects ->
Add
También se pueden usar ficheros jar
Project-> Properties->Java Build Path -> Libraries ->
Add
Un proyecto se puede exportar a formato jar desde el
propio Eclipse
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Inner Class

En java podemos definir una clase dentro de la
definición de otra
La clase interna se denomina «Inner Class»
La clase que la contiene se denomina «Outer Class»
La clase interna puede acceder a todas las
características de la clase que la alberga (incluso las
privadas)
Las instancias de la clase interna están asociadas a
una instancia de la clase externa
Las instancias de una clase interna sólo pueden ser
referenciadas desde el exterior de una forma
totalmente cualificada
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Ejemplo de clase interna

public class VistaVida extends SurfaceView
implements SurfaceHolder.Callback {

...
class Hilo extends Thread {

...
public Hilo(SurfaceHolder s, VistaVida v) {

surfaceHolder = s;
vista = v;

}
public void setActividad(boolean b) {

corriendo = b;
}
...
}

}
}
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Clase anónima

Podemos definir una clase local a un método («Local
Inner Class»)
Incluso podemos definir una de esas clases sin darle
nombre («Anonymous Inner Class»)

Extiende una clase
Implementa una interfaz

Encontraremos muchas clases anónimas en la
gestión de los eventos

Un único gestor de eventos, con una alternativa
múltiple
Un gestor especializado para cada evento (anónimo,
generalmente)
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Ejemplo de clase anónima

public class LogTextBox1 extends Activity {
...
@Override
protected void onCreate(Bundle savedInstanceState) {

super.onCreate(savedInstanceState);
setContentView(R.layout.log_text_box_1);
Button addButton = (Button) findViewById(R.id.add);
addButton.setOnClickListener(new View.OnClickListener() {

public void onClick(View v) {
mText.append("This is a test\n");

} });
}
...

}
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Hilos de ejecución

Un hilo es una tarea que puede ejecutarse en
paralelo con otras
Varios hilos comparten los mismos recursos
En Java, podemos utilizar hilos extendiendo la clase
Thread y redefiniendo el método run

Arrancamos el hilo mediante el método start()

También se pueden usar hilos implementando la
interfaz Runnable
El estudio de los hilos de ejecución excede los
objetivos de esta asignatura.
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Definición de un hilo

class Hilo extends Thread {
private SurfaceHolder surfaceHolder;
private VistaVida vista;
private boolean corriendo;
public Hilo(SurfaceHolder s, VistaVida v) {

surfaceHolder = s;
vista = v;

}
public void setActividad(boolean b) {

corriendo = b;
}
@Override
public void run() {

Canvas c;
while (corriendo) {

c = surfaceHolder.lockCanvas();
vista.onDraw(c);
surfaceHolder.unlockCanvasAndPost(c);

}
}

}
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Uso de un hilo

public VistaVida(Context context, UniversoVida u) {
super(context);
...
hilo = new Hilo(holder, this);

}
@Override
public void surfaceCreated(SurfaceHolder holder) {

hilo.setActividad(true);
hilo.start();

}
@Override
public void surfaceDestroyed(SurfaceHolder holder) {

boolean falla = true;
hilo.setActividad(false);
while (falla) {

try {
hilo.join(); // Espero a que termine hilo
falla = false;

} catch (InterruptedException e) {// Reintentar
}

}
}

}
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Uso del depurador

Eclipse dispone de un depurador de código
Puede usarse incluso con un dispositivo externo

Hay que añadir android:debuggable="true" en el
elemento
<application> dentro de AndroidManifest.xml

Habitualmente se usa desde una perspectiva
específica
Se añade algún «BreakPoint»
Se ejecuta mediante el icono correspondiente o
mediante Run -> Debug
La ejecución se realiza normalmente hasta llegar al
«BreakPoint»
Se pueden añadir nuevos puntos durante la
depuración
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La perspectiva «debugger»
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Uso del depurador

Podemos analizar el valor de las variables durante la
ejecución
Podemos añadir puntos de parada condicionales,...
Controlamos la ejecución a partir de la primera
parada

F5 (Step Into) Continúa la ejecución parando en los
métodos a los que llamamos
F6 (Step Over) Continúa la ejecución sin parar en los
métodos a los que llamamos
F7 (Step Return) Continúa la ejecución parando en el
código del método que nos invoca
F8 (Resume) Continúa la ejecución hasta el siguiente
«BreakPoint»

Sólo muestra el código disponible desde eclipse
«Android Source Plugin» permite ver el código del
framework
(http://code.google.com/p/adt-addons/)
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Implementación de la interfaz

Para mostrar las células y su evolución podemos
utilizar varias estrategias:

Una interfaz basada en botones o etiquetas: Presenta
problemas con universos de tamaño moderado o
grande
Una interfaz dibujada en un descendiente de View: La
interfaz se desenvuelve con menos soltura
Una interfaz dibujada en un descendiente de
SurfaceView: Presenta la complicación extra de
gestionar hilos

Sólo comentaremos las peculiaridades de las dos
últimas alternativas
En ambos casos, nuestra clase será cargada en una
Activity mediante setContentView(vista)
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Dibujar en una vista

Dibujamos sobre un objeto Canvas mediante
drawPath(path,paint)

El objeto Path representa el elemento que será
dibujado

Creamos un nuevo objeto Path
Le añadimos elementos geométricos: círculos
(addCircle),
curvas cúbicas de Bezier (cubicTo),. . .

El objeto Paint representa el estilo y color con que
será dibujado

Creamos un nuevo objeto Paint
Le añadimos color con setColor
Podemos añadir sombras (setShadowLayer) u otros
efectos.
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Dónde escribir los comandos de dibujo

Los comandos anteriores son invocados por el
método onDraw de la vista
Quien nos invoca desde el código del framework nos
pasa el objeto Canvas como argumento
La invocación a onDraw se realiza cuando el
framework «lo considera necesario»
Podemos forzar la llamada al método «invalidando»
todo o parte de la vista mediante una llamada a
invalidate

Para conseguir un efecto de «animación»
recalculamos el dibujo e invalidamos la vista al final
del propio método onDraw.
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Extender SurfaceView

Extendemos SurfaceView e implementamos
SurfaceHolder.Callback

Esta interfaz requiere que implementemos tres
métodos para reaccionar a los cambios de la vista:
surfaceCreated,surfaceDestroyed y
surfaceChanged

En el primer método creamos un hilo encargado de
redibujar la vista
En el segundo método detenemos la ejecución del
hilo y, en su caso, lo destruímos
Los comandos de dibujo son iguales a los de la
versión anterior, pero ahora no «invalidamos» la vista.
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Ciclo de vida de las actividades

Debemos prevenir
la pérdida del
foco por parte de
nuestra
aplicación:

onPause debe
guardar el
estado actual
de la actividad
onResume
debe
recuperar el
estado de la
actividad

En general,
necesitaremos
utilizar ficheros
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Nociones básicas sobre ficheros en Android

Cada aplicación se corresponde con un usuario UNIX

Su nombre es el nombre del paquete
Cada aplicación puede usar libremente su directorio
HOME

El HOME de una aplicación es /data/data/<paquete>
Para evitar problemas con versiones posteriores de
Android utilizar getFilesDir() de la clase Context

La clase Context proporciona algunos servicios de
manejo de ficheros (deleteFile, fileList,. . . )
En general, el manejo de ficheros utiliza las técnicas
habituales en java.
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Escribiendo en un fichero

@Override
protected void onPause() {

super.onPause();
Log.d(TAG, TAG + ": Escritura en fichero");
BufferedWriter fichero;
try {

fichero = new BufferedWriter(new FileWriter(
getFilesDir()+"/prueba.txt"));

fichero.write("Escribo en un fichero");
fichero.newLine();
fichero.close();

} catch (Exception e) {
Log.d(TAG, TAG + ": Error al escribir");
e.printStackTrace();

}
}
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Leyendo de un fichero

@Override
protected void onResume() {

super.onResume();
Log.d(TAG, TAG + ": Lectura de un fichero");
BufferedReader fichero;
try {

fichero = new BufferedReader(new FileReader(
getFilesDir()+"/prueba.txt"));

String linea;
while ((linea = fichero.readLine()) != null)

Log.d(TAG, TAG + ": Última lectura −−−−>"
+ linea);

} catch (Exception e) {
Log.d(TAG, TAG + ": Error al leer ");
e.printStackTrace();

}
}
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Ficheros en la SD

Las aplicaciones también pueden usar la «SD»
Está montada en /mnt/sdcard
Para evitar problemas con versiones posteriores de
Android utilizar getExternalFilesDir() de la clase
Context

Para escribir en la SD es preciso disponer de permisos
especiales declarados en AndroidManifest.xml

Las funciones usadas para abrir, cerrar, leer o escribir
ficheros son las mismas
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El selector de ficheros

El framework de Android no dispone de un diálogo
para seleccionar ficheros
Si realmente lo necesitamos podemos:

Implementarlo desde cero
Utilizar una biblioteca externa
Utilizar una aplicación externa

Quizás en realidad no necesitamos un selector de
ficheros.
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Utilizar una biblioteca externa

http://code.google.com/p/android−file−dialog/
Lanzamos una actividad externa para seleccionar el
nombre del fichero
Utilizamos startActivityForResult para poder
recuperar el resultado
La actividad llamada utiliza
setResult(codigo, intent) para devolver un
resultado
Al terminar la actividad el sistema llama a
onActivityResult()

requestCode es el código de la llamada
resultCode es el código del resultado
data encapsula los datos enviados mediante un
Intent
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Utilizar biblioteca externa Android

Imprescindible si se utilizan conceptos del Framework
(Recursos, actividades,. . . )
Hay que declarar la biblioteca en Properties ->
Android -> Library
Todos los proyectos usados tienen que estar abiertos
para compilar
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Utilizar una aplicación externa

http://www.blackmoonit.com/ ofrece un
administrador de archivos
«bien documentado»
Lanzaremos un intent implícito mediante
startActivityForResult

Podemos detectar desde el código si existe alguna
aplicación capaz de aceptar el intent

Utilizamos PackageManager
Podemos ofrecer la instalación de la aplicación si es
necesario

En el emulador no funciona si no hemos instalado
Android Market
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Ofrecer nuestra aplicación

Podemos «ofrecer» alguna de nuestras actividades
para realizar un trabajo
Declaramos un intent−filter asociado a la
actividad

Qué tareas podemos hacer
Qué tipo de datos podemos procesar

El proceso realizado depende de nuestro intent
Devolvemos resultados modificando nuestro intent
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Ofrecer nuestra aplicación:intent-filter

El intent−filter aparece en el fichero
AndroidManifest.xml

Cualquier aplicación tiene un intent−filter
asociado a su actividad principal
Podemos añadir intent−filter asociados a
cualquier actividad
Filtramos mediante categoría, acción, esquema,. . .
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Ofrecer nuestra aplicación: Procesar el intent

Una actividad puede ser iniciada de varios modos
Accedemos a nuestro objeto Intent mediante
getIntent()

Discriminamos las formas de activación en función
de los datos de nuestro objeto Intent

Modificamos nuestro objeto Intent para devolver un
resultado
Antes del final de la actividad debemos invocar al
método setResult para devolver un resultado
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